
 

 
 

Castor-WATER  5.0  
 

Software for analysis, prediction and design of pollutant discharges into 
diverse water bodies. 

 
 

User's  Manual 
 

 
 

Castor  
Environmental Software, C.P. 

28034 Madrid, Spain 
www.environmental-impact.eu  

 
 

 
 Printed on recycled paper. 



Castor   
 

 

 

II 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
© 00/2004/2150 
 
© Copyright 2001 Protected by copyright law and international treaties. 
Unauthorized reproduction or distribution subject to severe civil and criminal 
penalties. 
 
 



                                                                                                                                        
CastorWATER 
 

III 

 

IMPORTANT. READ ATTENTIVELY 
 

CASTOR-WATER FOR WINDOWS 95 
 
 
This License agreement for the End user of an application carried out by Castor 
Software (Castor Software) constitutes a legal agreement among you (either a person 
or an entity) and Castor Software regarding the software of Castor that includes 
the software and other related means, the printed materials (as the user's manual) 
and any other documentation (software). If you install, or you copy or you use this 
software or the user's manual, you accept the terms of the present License 
agreement for the End user. If you don't agree with the terms of this License 
agreement for the End user, don't install or use this product software and their 
related means; and return it where you acquired it.  
 
 
 

LICENSE OF SOFTWARE 
 
The software is protected by author's laws, by international treaties on copyright 
and by other laws and treaties on the intellectual property. The software carried 
out by Castor Software is allowed to use with license, it is not sold.  
 
Concession of License, The License agreement for the End User grants the following 
rights: 
 

 Software of Applications.- You will be allowed to install and to use a copy 
of the software in a PC. The main user of the PC will be able to make a 
second copy for his exclusive use in a portable PC. 

 
 Storage and use in the net.- You will also be allowed to install or to store 

a copy of the software in a storage device just as a network server.  
 

 However, you will acquire a license for each PC in which you can execute the 
software. You won't be allowed to share neither to use simultaneously in 
different PCs a license for the software. 

 
 Software not for sale.- It is not allowed to resell, or to transfer, for any 

money the software. 
 
 
Other rights and limitations. 
 

 It is not allowed to use technical of inverse engineering. 
 

 The software is granted with license as a unique product. Their components 
cannot separate to be used in more than a PC. 

 
 It is not allowed to rent or to lend the software. 

 
 All the rights shown in the License agreement for the End user can only be 

transferred with the condition that the receiver accepts the terms of this 
License agreement for the End user. 

 
 Without prejudice of any other right, Castor Software can finish this License 

agreement for the End user if you don't fulfill the terms and conditions of 
the contract. In this case, you will destroy all the copies of the product 
software and their components. 

 
Copyright:  The ownership and copyright with regard to the software, the printed 
materials that accompany it and any copy of the product software is property of 
Castor Software. The software is protected by copyright laws and by international 
treaties. Consequently, you will try to the software like any other material 
subject to copyright with the difference that you will be allowed to install the 
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software in a single PC. It is not allowed to copy the printed materials that 
accompany to the software. 
 

****** 
 

The parties to this agreement are Castor Software, hereinafter referred to as 
"Castor Software" the CASTOR-WATER software user hereinafter referred to as 
"Licensee." 
 
EFFECTIVE DATE: This agreement shall take effect upon execution. 
 
LICENSED MATERIALS: Castor Software hereby grants to Licensee one (1) non-
exclusive, non-transferable, and royalty-free license to install the Licensed 
CASTOR-WATER system (application and user’s manual) on one computer, which is 
incorporated herein by reference. One computer is defined as one unique combination 
of Operating System(OS)/ Processor(CPU) / Hard Drive(HD). 
 
LICENSE PROVISIONS: Castor Software shall have no obligation to provide support, 
including but not limited to installation, maintenance, debugging and improvements, 
for Licensed Materials, except as Castor Software at its sole discretion, shall 
determine to be reasonable. Licensee agrees to make available to Castor Software 
any modifications or enhancements to the Licensed Materials provided under this 
agreement. Castor Software shall have the right to use such modifications and 
enhancements for any purpose whatsoever. 
 
NOTICES: Any notices required to be given or which shall be given under this 
agreement shall be in writing delivered by first-class mail. Notices shall be 
addressed to the parties as follows: 
 

License Manager 
Castor Software, SLU 

 
WARRANTIES: Licensee agrees to accept the Licensed Materials on an "as is, with all 
defects" basis. Castor Software makes no warranties, express, implied in law or in 
fact, including any implied warranty of merchantability or fitness for a particular 
purpose, or results obtained from Licensee's use of Licensed Materials, or that the 
use of any Licensed Materials will not infringe on any patent, copyright or 
trademark or other rights. 
 
LIABILITY AND INDEMNIFICATION:  Castor Software shall not be liable for any manner 
of loss or damage arising out of the use of the materials provided hereunder. 
Further, Castor Software shall not be obligated to indemnify the Licensee in any 
manner for any loss which Licensee may experience, of any kind or nature, arising 
out of the use of the materials. 
 
ASSIGNMENT: This agreement shall inure to the benefit of and be binding upon the 
parties, and their respective successors and assigns. This agreement shall not be 
assigned by either party without the written consent of the other party thereto. 
 
GOVERNING LAW: This agreement shall be interpreted, enforced and construed 
according to the laws of the Kingdom of Spain. 
 
ENTIRE AGREEMENT: This agreement contains the entire agreement between the parties 
with respect to the subject matter hereof, and it shall not be modified or amended 
except by an instrument in writing signed by both parties hereto. 
 
 
 
 

Castor Environmental Software, C.P. 
28034 Madrid, SPAIN 
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DISCLAIMER 
 
 The present document has been carried out by Castor Software in its entirety. 
Any mention that we can find in the manual of companies, official organisms, names, 
products or trademarks don't imply the participation of these in the realization of 
the present document neither in the development of the software. On the other hand, 
the mention that we can find in the manual of companies, official organisms, trade 
names, products or trademarks don't mean that they are recommended by Castor 
Software. The information contained in this document has been obtained by Castor 
Software of credible sources. Nevertheless, Castor Software doesn't guarantee the 
accuracy or perfection of the published information. Castor Software won't become 
responsible for any error, omission or damage caused by the use of the information 
of the manual present and of the software. With the use of the software and manual, 
Castor Software is not providing any specific professional service to carry out 
technical studies. Specialized professionals, hired for this, will carry out the 
pertinent studies. 
 
 The CASTOR-WATER software estimates the dispersion of pollutants in the 
water. These types of numeric simulations are a method to estimate the 
contamination in an approximate way. Castor Software doesn't guarantee that the 
results obtained by this program coincide with the real concentrations that we can 
find in the water. The software, the used algorithms and the manual have been 
conscientiously examined of the possible existence of errors or omissions. Although 
we have checked the operation of CASTOR-WATER keeping in mind the results that we 
can find in the existent scientific literature on the area, Castor Software is not 
responsible for errors or omissions that we can find in the software, in the used 
calculation algorithms and in this manual. Castor Software is not responsible for 
losses or damages caused by the use of this software or of the user's manual. This 
software has been conscientiously examined of the possible existence of computer 
virus before its distribution.  
 

Although we have used programs up-to-date antivirus of last generation and we 
have taken the maximum cautions in the development of the program and of the 
installation system, Castor Software is not responsible for losses or damages 
caused by these. We recommend that it maintains backup copies of all their 
fundamental data before installing the software. 
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FOREWORD 
 
The numeric algorithms that CASTOR-WATER uses gives us the possibility to study a great quantity of 
water pollutants that we find in our environment. The numerical method uses a equation that estimates 
the dispersion of the pollutants in the water.  
 
The software admits meteorological data to establish the form of the polluting plume. The software 
calculates the pollutant concentration that is produced by each one of the sources and it considers the 
estates of the pollutant and the state of the water currents. CASTOR-WATER carries out temporary 
averages (daily, monthly or annual) so that you can calculate the concentration average in each point 
of the affected area.  
 
The system of simulation of processes of dispersion that CASTOR-WATER has, offers to the beginner 
and the expert programmer, a quick and practical system to evaluate the dispersion of pollutants in the 
water. The program is based on the operating system Microsoft WINDOWS where one works 
intensively with the mouse and the graphic windows. The bars of icons facilitate the realization of the 
different tasks of the program. We can say, with a certain security that the software CASTOR-WATER 
is one of the best tools, to carry out numeric simulations of water pollution processes. Without 
considering the experience that the user possesses in programming languages or in the use of 
simulation tools, in few minutes he will be able to have the first results.  
 
This manual will describe the use and the possibilities of CASTOR-WATER that we will show with the 
use of examples. It is not strictly necessary possessing knowledge on the handling of the operating 
system of Microsoft WINDOWS although it is advisable. Along the user's manual we will simulate 
some water pollution processes whose development will illustrate the use of the program in the case of 
complex systems. We will describe the necessary steps for the study of a water pollution process with 
the software.  
 
Finally, we will say that they exist in the scientific literature a great quantity of models to evaluate the 
dispersion of pollutants in the water. In this way, we will obtain numeric differences among the results 
of the program and the results of other numeric models. This is not strange since there are numeric 
differences among the different models of the scientific literature. The problem is that the dispersion is 
a complex physical phenomenon (that involves turbulences, non-linear dynamics and thermodynamic 
of the irreversible processes) and we want to simplify it with a simple equation. On the other hand, we 
will add that this approach type is the most reasonable that we can think about to evaluate the water 
pollution.
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1. Introduction 

  
 

Our planet is fragile and limited as for its potential of 
generating the resources that the humanity requests and her 
capacity to absorb the residuals that we emit. The 
precariousness of the ecological and environmental resistance 
of the earth can end up threatening the humanity's 
development. IUICN, PNUMA, WWF and Agenda 21 plead insistently 
to reach the sustainable development. This admits a growth and 
an evolution of the carrying capacity of the ecosystems, 
without committing the necessities of the future generations, 
by means of the environmental administration of the different 
places of the Planet. 

 
 

2. Administration and Environmental Impact 
 
 

The environmental administration is based on two 
fundamental tools:  the planning and the evaluation of the 
environmental impact. These two instruments are fundamental to 
coordinate the human activity and to maintain the quality of 
the environmental resources. The process of environmental 
planning combines the characteristics of each place with the 
possibilities of economic development. We will define 
administration objectives that will achieve the optimization 
of the use of the resources minimizing the impact generated on 
the environment. We will define the environmental impact that 
suffers a certain region as the difference among the future 
environmental situation of the place, after the realization of 
a project, and the environmental state of the area if this 
project had never taken place.  The correct diagnosis of the 
impact demands to know all the elements implied in the 
environmental process. A study of environmental impact will 
also include a planning of the environmental surveillance of 
the project.  

 
 One of the fundamental physical systems for the study 
of the environmental quality of a region is the water. The 
water and the ground play a important role in the development 
of the life. In this software, we will center ourselves in 
the study and in the administration of the water.  
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The outfall pipes, which release sewage, are mainly in 

the sea near the coast, in rivers and in estuaries. CASTOR-
WATER Software can simulate both situations. The main 
pollutants in the water are: organic compounds, heavy metals, 
organic chemicals, oil slicks and thermal water.   

 
 

Organic wastes.- It is the main compound of wastewater 
discharges. The most important discharges with organic 
compounds are the home sewage and the industrial 
wastewaters. This type of discharge experiences a very 
important demand of oxygen (BOD = biochemical oxygen 
demand). Putting too much sewage into a water body can 
place too severe an oxygen demand on the water, leading to 
major pollution problems. Water without pollutants can have 
a DOB between 1 and 2 mg/L. Raw sewage has a DOB between 
300 and 400 mg/L (1mg/L=1g/m3, 1g/m3=1ppm, 1L=1dm3). 
 
 
Heavy metals.- Some heavy metals like the Cu and the Zn are 
not biodegradable and they are deposited in mollusks that 
filter great quantity of water, as the mussel. These metals 
are toxic in high concentrations and they can produce a 
problem for the health when they are ingested. 
 
 
Organic chemicals.- Some of these compounds like the 
pesticides and the PCB can cause a great impact in the 
environment. 
 
 
Thermal waters.-  They are cooling waters from industrial 
and electric power plants. They may raise the temperature 
of the receiving water, increasing the rate of 
decomposition of biodegradable organic wastes.  
 

 

3. The Water 
 
 

It is an indispensable element for the life. 97% of the 
water of the Earth is in the oceans. 70% of the surface of our 
planet is covered by the water. The water is in seas, rivers, 
lakes and ice. The water is always moving, from the earth and 
the oceans to the atmosphere and vice versa. Taking advantage 
of these movements, the water transports mass and energy. The 
water dissolves the soluble compounds of the minerals and it 
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transports them until the oceans or it deposits them in far 
away places. The water transports the nutrients of the plants 
in its interior. The water absorbs solar energy when it 
evaporates in the ocean. The energy is liberated when the 
water condenses. The rain dissolves the present substances in 
the atmosphere: oxygen, nitrogen, dioxide of carbon, sulphur 
oxides and nitrogen oxides. In very industrialized areas where 
big quantities of oxides of sulphur and of nitrogen are 
emitted to the atmosphere, the degree of acidity of the rain 
can be between 10 and 100 times superior. This generates big 
problems in lakes, forests and even constructions. 

 

3.1 Physical characteristics 
 

Colour: It is due to the dissolved minerals and the organic 
matter.  

 
Turbidity: It is caused by the dissolved matter that 
disperses and absorbs the light.   
 
Odour: It can be due to the presence of inorganic or organic 
substances. 
 
Temperature: The disturbance caused by the rise in 
temperature of the water is called thermal pollution. It has 
a number of bad effects. Oxygen is less soluble at the 
higher temperature. If the temperature rises sufficiently, 
fish may die. The situation is made worse by the speeding up 
of biochemical processes so the fish respire more rapidly 
and need more oxygen. 
 
 

 

 

 

 

 

 

 

 

 

 

Oxygen concentration 

in the water 

Temperature 

(ºC) 

Oxygen 

(g/m3) 

0 1.42 

5 12.4 

10 10.9 

15 9.8 

20 8.8 

25 8.1 

30 7.5 
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Density and thermal stratification: The intense heating 
caused by sunlight results in the formation of a light, 
warmer layer of water floating on top of a much larger mass 
of cold, dense water. Where these two bodies of dense water 
meet there is a zone of rapid change in the water 
temperature, called the thermocline or pycnocline. Such a 
thermocline is a permanent feature of both tropical and 
temperature waters. When the surface water of temperature 
seas is warmed in the summer a further seasonal thermocline 
can develop much closer to the surface. This is much 
stronger feature than the permanent thermocline in 
temperature waters. This thermocline plays an important role 
in determining seasonal changes in marine primary production 
in temperature seas. Thermal stratification represents a 
physical barrier to the mixing of the water column. There is 
little or no exchange of nutrient through a thermocline.  
 
 
Suspended solids: Their size can be of the order of 
millimeters (for example in waste waters) up to 10-9 m. 
(dissolved solids).   
 

3.2 Chemical characteristics 
 

The chemical characteristics of the water are in function 
of the dissolved substances. 
 

pH:  The mineral waters have a pH value between 6 and 9, the 
seawater has a value of 8 and the rain of 5.6. Significance: 
intensity of acid or alkali present. 

 
 

4. Water pollution 
  

Natural waters contain micro-organism as well as solutes. 
There is a distinction between ‘pure’ water, meaning water 
that is fit to drink and pure water that is a single 
substance. A water pollutant is a substance that prevents the 
use of water for a specified purpose. The signs of polluted 
water are obvious. Poor drinking water tastes and smell bad. 
Many types of substances which are classified as pollutants 
are listed. 

 
1. Pathogens, bacteria and viruses 
2. Dissolved organic compounds and inorganic compounds 
3. Wastes that have a biochemical oxygen demand 
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4. Nutrients that cause excessive growth of plants 
5. Thermal pollution 

 
 

4.1 Biochemical Oxygen Demand 
 

The Oxygen is used for respiration of animals. Fish 
require the highest concentration of oxygen. If the dissolved 
oxygen falls below 5ppm (part per million), fish are the first 
to suffer and tend to die out. Then, the population of 
bacteria rises to abnormal levels. The imbalances between 
species is a sign of water pollution. Substances which use up 
dissolved oxygen and add to the biochemical oxygen demand are 
pollutants. Such substances come from the human wastes. The 
amount of dissolved oxygen used up during oxidation by 
bacteria of the organic matter in a sample of water is called 
Biochemical Oxygen Demand (BOD). Water is rated as pure if BOD 
is 1ppm or less, fairly pure with a BOD of 3ppm and suspect 
when the BOD reaches 5ppm. 
 

 
 

Water 

Upper limit 
of BOD5 

(European 
Union) 
(mg/L) 

Pure waters < 1 
Polluted rivers (upper 
limit in European Union) 

> 5 

Polluted rivers with salmon 
(upper limit in European 
Union) 

3 

Polluted rivers with other 
fish (upper limit in 
European Union) 

6 

Waste waters 150-1000+ 
Industrial waste waters thousands 

 +BOD, not BOD5 
 1mg/L=1g/m3=1ppm 

BOD is calculated in 20 days. BOD5 is   calculated in 
5 days, BOD=5BOD5. 
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4.2 Eutrophication 
 

In order to grow, plant require about 20 different 
elements (carbon, hydrogen,…). In normal conditions, water 
always provides enough elements for plant growth. The rate of 
growth is limited by the supplies of nitrogen and phosphorous. 
Lake water may be enriched with nutrients (a process called 
eutrophication) which encourages plant growth and leads slowly 
to ageing. Ageing is accelerated when plant nutrients are fed 
into a lake by human activities (fertilisers, wastewater 
containing detergent,…). When a lake contains concentrations 
of nitrates and phosphates higher than the normal, algae 
flourish and produce a bloom, a green scum which is 
accompanied by an unpleasant odour in the water. The lowering 
of oxygen concentration leads to the death of fish. The 
sources of nitrates and phosphates are sewage and fertilisers. 
Intensively cultivated land receives generous applications of 
fertilisers containing nitrates and phosphates. 
 
 
Nitrates: The World Health Organization recommends that the 
level of nitrogen in the form of nitrates should not exceed 
50ppm. The averaged level in the UK is about 11ppm.  

 
 
  

Water 

Upper limit 
(different 

compounds with 
nitrogen) 

Rivers with water of 
good quality 

1mg/L 

Rivers with salmon 1mg NH3-N/L 
Drinking water 0.1mg NO2-N/L 
Rivers with salmon 0.01mg NO2-N/L 
Drinking water 40mg NO3—N/L 
Rivers with salmon 1mg NO3-N/L 

       
  

 
Phosphates: Phosphates enter water from fertilisers and from 
detergents. Phosphates are added as builders to improve the 
cleaning power of synthetic detergents. To inhibit the growth 
of algae, a phosphate level below 0.5mg/L is the aim. The 
lakes can become eutrophic if the concentration of phosphates 
overcomes the 30ug/L  
(1ug/L=10-6g/dm3). The upper limit in European Union for 
polluted rivers with salmon is 65ug/L.    
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4.3 Dissolved organic compounds 
 

Natural organic compounds have been present in the 
environment for millions of years. Many synthetic chemicals 
are harmless to living things, but some interfere with 
biochemical processes. Some of these synthetic chemicals are 
purposely introduced into the environment to kill insects. 
Some organic compounds pollute waterways. They are especially 
dangerous if they are not biodegradable. Some, like DDT, are 
concentrated by passage through a food chain. 
 

4.4 Acidic pollutants 
 

A source of acidic inorganic pollutants is the drainage 
of water from mines. Water flowing from underground mines is 
usually highly acidic. In lakes and rivers, the acids react 
with carbonate ions to form carbon dioxide. A raised level of 
carbon dioxide in the water makes it more difficult for 
animals to respire. Extreme acid pollution kills aquatic 
plants and animals. 
 

4.5 Cyanides 
 

Cyanides are widely used in industry for cleaning metals. 
Cyanides enter waterways in effluents from industries. The 
toxic effect of cyanide is due to the formation of a complex 
with iron.  
 

4.6 Aluminium 
 

Aluminium ions are present in the water supply because 
aluminium sulphate is used in water treatment. There is 
evidence of a correlation between Alzheimer’s disease and the 
aluminium content of drinking water. The rate of Alzheimer’s 
disease in districts where the concentration of aluminium in 
drinking water exceeds 0.11mg/L (1mg=0.001g, 1L=1dm3) is higher 
than the rate in districts where the aluminium concentration 
is less than 0.01mg/L. 
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4.7 Cadmium 
 

Pollutant cadmium in water may came from industrial 
discharges. Heavy metals are serious water pollutants. Cadmium 
is highly toxic, with a recommended upper limit of only 10ppb 
(part per billion, 1000ppb=1ppm). 
 

4.8 Lead 
 

Leaded petrol is a source of lead in the atmosphere. 
Particles of soot and lead compounds from vehicle exhausts can 
fall on land and contaminate. Lead come from lead pipes and 
solders, from lead glazes on pottery and glasses. The World 
Health Organisation recommends that the limit for lead in 
drinking water should be 50 ug/L. 
 

4.9 Mercury 
 

Mercury compounds are found in nature in low 
concentrations in rocks and soils. However, we find a variety 
of uses for mercury which add mercury to the environment. 
Mercury comes from mercury cathode electrolysis cell, from 
fungicides, paints, coal and disinfectants. It has accumulated 
in a number of lakes. Mercury is slowly converted into 
dimethylmercury and methylmercury which are soluble and can be 
ingested by animals. Sludge from sewage treatment plants 
contains about 1ppb of mercury. 
 

4.10 Chromium 
 

Chromium compounds are toxic and irritating. They are 
present in wastes from electroplating plants and tanneries. 
 

4.11 Nickel 
 

Nickel compounds came from electroplating plants and 
cause damage to brain. 
 

4.12 Copper 
 

Copper compounds are toxic. If the dose is high enough. 
It can damage brain and eyes. 
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4.13 Zinc 
 

Zinc enters the water supply from galvanising plants. It 
is relatively non-toxic, but large doses cause vomiting. 
 

4.14 Arsenic 
 

Contamination by agricultural pesticides has occasionally 
been a source of arsenic poisoning. It comes from the 
combustion of fossil fuels and is concentrated in food chains. 
The level of arsenic in natural water is 2ppb. Ingestion of 
100mg of arsenic by an adult is fatal. The recommended upper 
limit for drinking water is 50 ppb. 
 

4.15 Thermal pollution 
 

The rise in temperature of the water is called thermal 
pollution. Water is taking from waterways, used for cooling, 
and returned to waterways. It decreases the solubility of 
oxygen, increase the metabolic rate of organism,… If the 
temperature rises sufficiently, fish may die. 
 
 
 

5. Before you begin 
 

Welcome to Castor-WATER - software for analysis, 
prediction and design of pollutant discharges into diverse 
water bodies. The CASTOR-WATER software allows you to create 
robust and useful numeric simulations that fully make use of 
the graphical user interface. This chapter show you how to sep 
up CASTOR-WATER on your computer. 
 

We can say, with a certain security that the software 
CASTOR-WATER are one of the best tools, if not the best and 
simpler, to carry out numeric simulations of pollutant 
discharges into the water. It takes just a few minutes to 
build your first numerical simulation. 
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Due to the features of the software that allows to simulate the 
process of pollutant discharges into water immediately, the numeric 
simulation is carried out with a remarkable speed.  

 

You create the graphical interface for your pollutant 
discharges by drawing point sources in a graphical way. You 
create the simulation process by drawing point sources, such 
as outfall pipelines, on the CASTOR-WATER window. Next, you 
set properties for the point sourcas and water currents to 
specify such values as density, concentration,… Finally, the 
numeric simulation is carrier out. 

 

5.1 CASTOR-WATER Software 
 

Before you attempt to install and use the program, make 
sure your personal computer meets the hardware and software 
requirements shown in the following table. 

 

 System requirements: Windows 95, 98, 2000 and XP 

 CD-ROM drive 

 RAM Memory: 16MB or higher 

 

 

5.2 Installation  
 

 Insert the CD. The CASTOR-WATER CD window appears on your 
screen. 

 Double-click the button labeled Setup and follow the 
instructions on the screen. 

 

If the CASTOR-WATER CD window does not appear, the CD autorun 
feature might be disabled on your computer. To install CASTOR-
WATER, open the CD-ROM drive icon, open the PC directory, and 
double-click the Installer icon. 
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5.3 Starting CASTOR-WATER 
 

Click Start, go to Programs, and choose CASTOR-WATER. 
Here is the program window after startup. 

 

 

 

 

 

 

The window has a Menu bar at the top, a Status bar at the 
bottom and a basic tool bar in the window. The program 
commands are available through the menus and toolbar buttons. 
Some commands have associated dialog boxes which you can 
choose additional options. 
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6. Understanding the Workplace 
 

The MS Windows bar doesn’t appear. In this way, you have 
more space to draw. However, and if you want, you can modify 
the properties of the MS Windows bar in the Microsoft Windows 
system. The program window size is fixed and it cannot modify. 
The menu bar lists the menus shown above. When you choose one 
of the menus, the program displays a pull-down list of 
available commands. The menu bar lists: File, View, Point 
source, Current data, Tools, Options and About CASTOR-WATER… 

The program window has a basic tool bar at the top. 

 

In the center of the program window, we will draw and we 
will calculate the different polluting processes. We can draw 
using two different planes: parallel to the surface of the 
water (XY) and perpendicular to the surface of the water (XZ). 
There is a grid in the XY-plane. The coordinate origin is on 
the left bottom corner (X=0, Y=0) in XY-planes (parallel to 
the surface of the water). In addition, the coordinate origin 
is on the left bottom corner (X=0, Z=0) in XZ-planes 
(perpendicular to the surface of the water).  

 

XY-Plane (parallel to water surface):  

 

In such a case, the program window is a XY-plane (parallel to the 
water surface). A pollutant point source (outfall pipeline) is 
represented by a small square. 

 

In the Status bar at the bottom, we have X,Y and Z coordinate 
values in meters and data on our environmental system. Point 
the mouse where you want in the program window and the X,Y and 
Z values will be shown in the status bar at the bottom. If you 
select XY-Plane, a grid appears. 

 

On the left bottom corner, two different text boxes appear: The 
position of the XY-plane with respect to the water surface (XY-plane 
height) and the pollutant concentration value (grams per cubic 
meter, g/m3). Point the mouse where you want in the program 
window and the concentration value will be shown in the text box. 
Remember that 1g/m3=1mg/L. 
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The pollutant concentrations will be calculated in a parallel 
plane to the water surface (XY-Plane). The plane height will 
be determined by the user (zr).  

 
 

 
 
 
 

All the points of the XY-plane will be to a zr height. The zr 
value is chosen by the user before the calculation. We will be 
able to make many calculations considering different plane 
heights. The different plane heights will be determined by the 
user (zr values). In this way, the physical form of the 
pollutant plume can be studied.  
 
Example: Calculation in the XY-plane, zr=0 (height of the 
water surface). The red square represents a point source 

0,2 g/m^3 

Point source  -  Program window  -  
Plane representation 

XY-Plane 

zr 
 

Coordinate origin 
(x=0, y=0, z=0) 
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(position of the outfall pipe). The red colour represents high 
pollutant concentrations. 
 
 
 
 

 
 
 
 
 
 
XZ-Plane (perpendicular to water surface):  

 

In such a case, the program window is a XZ-plane (perpendicular to 
the water surface). A pollutant point source (outfall pipeline) is 
represented by a small square. 

 

In the Status bar at the bottom, we have X,Y and Z coordinate 
values in meters and data on our environmental system. Point 
the mouse where you want in the program window and the X,Y and 
Z values will be shown in the status bar at the bottom. 
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On the left bottom corner, a text box appears: the pollutant 
concentration value (grams per cubic meter, g/m3). Point the mouse 
where you want in the program window and the concentration value 
will be shown in the text box. Remember that 1g/m3=1mg/L. 

 

The pollutant concentrations will be calculated in a 
perpendicular plane to the water surface (XZ-Plane). The plane 
height will be determined by the user (yr).  

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  
 
 
 
 
 
All the points of the XZ-Plane will be to a yr height. The yr 
value is chosen by the user before the calculation. We will be 

Coordinate origin 
(x=0, y=0, z=0) 

yr 

Program window –    XZ-
Plane representation  

 
 

0,2 g/m^3 

XZ-Plane 
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able to make many calculations considering different plane 
heights. The different plane heights will be determined by the 
user (yr values). In this way, the physical form of the 
pollutant plume can be studied. Example: Calculation in the XZ-
plane. The red square represents a point source (position of 
the outfall pipe). The blue line represents the surface of the 
water and the green line represents the bottom of the sea. The 
red colour represents high pollutant concentrations. 
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6.1 Menu Bar 
 

Display the commands you use to build your simulation. 
When you choose one of the menus, the program displays a pull-
down list of available commands. The program window has a 
basic tool bar under the Menu bar. The tool bar provides quick 
access to commonly used commands in the program. You click a 
button on the toolbar once to carry out the action represented 
by that button.  

 

For example, when you choose File in the Menu bar, the 
program displays: 

   

 

 

 

 



Castor   
 

 

 

20 

6.1.1 File 

 
The File Menu contains the tools you use to open, close 

and save new and existing files, and import and export 
graphics. The File Menu lists: New, Open, Save, Import 
Picture, Export Picture, Print, Print Picture and Exit. 

 

New.- This command is to begin a new simulation, deleting all 
that has been made previously.  

 

Save the work with the Save command before clicking the New 
command.  The program doesn't allow to open two files at the same 
time. This way, we can optimize the available memory and the 
calculation speed. 

 

Open.- This command is to open an existing file. The program 
files exist as separate files with .ems filename extension. 

 

Save the current work with the Save command before clicking the 
Open command.  The program doesn't allow to open two files at the 
same time. 

 

Save.- This command is to save an existing result.  

 

The process of saving a file is carried out proportionally to the size 
in which the elements are drawn in the screen. Then, the saved file 
will depend on the screen format that we are using (for example, 
1280x1024,…). If we try to read a file, saved in another different 
computer, we will have problems to open it. 

 

Import Picture.- With this command you will be able to import 
images and pictures (previously saved BMP files). These images 
will be background pictures and images for your program 
window. You can display an image by double-clicking the 
filename of a bitmap (BMP). 

 

Many programs and computer applications (AutoCad, 3d Studio, 
ArcView,...) export BMP files. You will be able to load pictures and 
images generated by these programs. 
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The displayed image size will depend on the size that had when 
it was saved. If it is necessary, modify the picture size 
before loading the image (for example, you can use windows 
Paint, Adobe Photoshop,… ). You will be able to load BMP maps 
generated by AutoCad. 

 

Bitmaps and scanned maps must be loaded into memory and then 
adapted to the program scale (we will make use of the Scale 
command). The X-Axis width (meters) in the program window can 
be easily changed to be able to compare both images 
(simulation results and background maps). Then, the X-Axis 
width (in meters) of the imported map and the X-Axis width (in 
meters) of the program window match together. The imported 
images are not stored physically in the simulation process. 
Terrain elevations (represented on the imported map) don’t 
interact in the simulation process. We haven't the possibility 
to zoom an imported map with the Zoom command. This command 
only acts in the calculation process. If it is necessary, zoom  
the map before loading the image. 

 

Export Picture.- With this command you will be able to export 
images and pictures (BMP files). These images will contain the 
background picture and the simulation results. 

 

Many programs, computer applications and word processors 
(AutoCad, 3d Studio, ArcView, MS Word,...) import BMP files. You 
will be able to load images generated by CASTOR-WATER. 

 

Print.- The users’ printer drivers and printers impact print 
quality. With this command you can send graphics and text (of 
the simulation results) to a printer. This command provides 
the best printing quality across a variety of printers because 
Windows translate text and graphics from the device-
independent drawing space to the Printer object to best match 
the resolution and abilities of the printer. However, the 
background pictures cannot be printed. 

 

Print image.- This command send a pixel-by-pixel image of the 
program window to the printer. To print with Print image 
command, you must first display that information on the 
program window and then print with this command. This command 
is by far the easiest way to print from your application.  
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Because it may send information to the printer at the 
resolution of the user’s screen (typically 96 dots per inch), 
results can be disappointing on printers with much higher 
resolutions (typically 300 dots per inch for laser printers).  

 

Exit.- The Exit command allows you to exit directly from the 
application. 
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6.1.2 View 
 

The View Menu contains the tools you use to view your 
computer screen. The File Menu lists: Zoom, Black background, 
White background, Draw grid lines, Eliminate grid lines, Draw 
picture, Eliminate picture, XY View and XZ View. 

 
Zoom.- We have the possibility to zoom a part of the program 
window with the Zoom command. However, we won't be able to 
enlarge background pictures with this command. If it is 
necessary, zoom the map before loading the background image. 
This command only acts in the calculation process. This way, 
we can place a point source in a side of the computer screen 
and we can calculate the concentrations in another different 
detailed region. 
 
 

 
 
 
To activate the Zoom command, eliminate the background picture 
first. 
 
Black background.- The Black background command allows you to 
have a black background colour in your screen. 
 
White background.- The White background command allows you to 
have a white background colour in your screen. 
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Draw grid lines.- If you select Draw grid lines command, the 
grid appears. 
 
Eliminate grid lines.- If you select Eliminate grid lines 
command, the grid disappears. 
 
Draw picture.-  With this command you will be able to see  
background images and pictures (previously loaded BMP files).  

 
Eliminate picture.- With this command you will eliminate  
background images and pictures (previously loaded BMP files).  
 
XY View.- With this command, you can draw using a plane that 
is parallel to the surface of the water (XY). 
 
XZ View.- With this command, you can draw using a plane that 
is perpendicular to the surface of the water (XZ). 
 
 

6.1.3 Point source 
 

The Point source Menu lists the possible pollutant 
sources: the outfall pipe. 
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Outfall.- This is a pollutant point source. The outfall is 
small if we compare it with the size of the area in which we 
are simulating (point source). If you click this button, the 
next dialog box is shown: 
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Depending on the used model, some data of the dialog box can 
be modified: Buoyant jet model or Stratified model (see 
calculation models). 

 

Buoyant jet model: The necessary data in the Buoyant jet model 
is: 

 

Effluent velocity ua (m/s): The average velocity of the 
pollutant effluent. It can be around 1 m/s. 

 

Pollutant concentration (g/m3): The discharge concentration 
of the material of interest (pollutant or tracer) is 
defined as the excess concentration above any ambient 
concentration of that same material. 1g/m3=1ppm in water. 

 

Water depth at discharge location (m): The actual water 
depth at the sumerged discharge location. For surface 
discharges it is the water depth at the channel entry 
location.  

 

Discharge flow rate (m3/s): The discharge flow rate and the 
discharge velocity are related through the port cross-
sectional area. (Flow rate)=(area)x(discharge velocity). 

 

Discharge density (kg/m3): It is the density of the 
pollutant discharge.  

 

Discharge conditions: There are three options: Vertical 
discharge, Horizontal discharge (A-type) and Horizontal 
discharge (B-type). In the vertical discharge, the discharge 
flow is perpendicular to the water surface. In the 
horizontal discharges (A and B), the discharge flow is 
parallel to the water surface. In the horizontal discharge 
case, we assume that the discharge vector is always 
perpendicular to current vector. That is to simplify the 
calculations. In the A-type, the flow vector points the 
South and the current vector points the East. In the B-type, 
the flow vector points the North and the current vector 
points the East. 
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Stratified model: The necessary data in the Stratified model 
is: 

 

Pipe angle (0 to 360): It is the horizontal angle of 
discharge measured clockwise from the North (at the window 
top). 

 

Diffusor length (m): The diffuser length is the distance 
from the first to the last port or nozzle. 

 

1/T90 (1/seconds): This coefficient considers the half life 
of the pollutant if this disappears by means of chemical 
reactions (non-conservative pollutant). This is the T90 for 
E.Coli. For towns with less than 10,000 inhabitants we can 
take a T90=2 hours (1/T90=0,5 hours-1) in the Mediterranean 
and T90=3 hours (1/T90=0,33 hours-1) in the Atlantic.  

 

Number of openings: CASTOR-WATER allows for different types 
of discharge geometries. There are three options: Single 
port, Multiport diffuser and Separated ports.  We have a 
multiport diffuser when the separation among the ports is 
less than 3% of the depth. We have Separated ports when the 
separation among the ports is bigger than 20% of the water 
depth. 

 

If you click the OK button, the next program window is shown 
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Two blue axis points the place where we can fix the outfall 
position. After clicking the program window, you draw the 
outfall. 
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The small red square shows the outfall location. We can draw 
all the outfalls that we want (up to 1,000). To change the 
discharge data, we can click the outfall location in the 
program window. Then, the discharge dialogbox is again 
displayed. We are not able to put two outfalls in the same 
location. The older is eliminated automatically. 

   

 

6.1.4 Current data 
 

Ambient conditions are defined by the hydrographic 
conditions in the vicinity of the discharge. This Menu lists: 
Current. 

  

Current.- CASTOR-WATER analyses, as all mixing zone 
evaluations, are usually carried out under the assumption of 
steady-state ambient conditions. If you click this command, 
the next dialog box is shown: 
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Depending on the used model, some data of the dialog box can 
be modified: Buoyant jet model or Stratified model (see 
calculation models). 

 

Buoyant jet model: The necessary data in the Buoyant jet model 
is: 

 

Water density (kg/m3): It is the density of the ambient 
water.  

 

Current velocity ua (m/s): The average velocity of the water 
current. The admitted minimum velocity is 0,0001 m/s. A 
typical velocity can be of about 0,015 m/s. 

 

Current angle (0 to 360): It is the horizontal angle of 
water current measured clockwise from the North (at the 
window top). For an outfall that is localized near the 
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coast, the vector of the current is usually parallel to the 
coast. 

 

Stratified model: The necessary data in the Stratified model 
is: 

 

Coefficient of stratification (s-2): Г represents the 
stratification degree in the water 

Г=-(g/ρa)(dρa/dh), 

being g the gravity acceleration, g=9,81m/s2, ρa the ambient 
water density and h the depth. A typical value can be 
0,00005 s-2 (The density of the seawater increases 5 kg each 
1000m).  

 

Stratified model: There are two options: Water is 
stratified and Water is not stratified. The stratification 
process usually happens in summer. 

 

6.1.5 Tools 
 

The Tools Menu contains the tools you use to process your 
data. The File Menu lists: Temporal average, Delete, Axis 
scale, XY-Calculation, XZ-Calculation, Colour gradient, 
Isolines, Numerical grid and Calculation parameters. When you 
choose Tools in the Menu bar, the program displays: 
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Temporal average.- Some discharge data can vary with time 
(velocity of the current, pollutant concentration,...). Taking 
this into account, the program can do temporal averages in the 
calculation. In the CASTOR-WATER software, these data are 
allowed to vary with time. If you click this command, the next 
dialog box is shown: 
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We can write in the text box the number of temporal points per 
average. To be able to make an average, we will take more than 
a temporal point. 

 

The temporary points are elements of an average and we will be 
able to relate them with any temporary instant. That is to say, if we 
have data of currents for every hour of one day (a total of 24) and 
we want to make an average of the pollution in one day, we will be 
able to make a temporal average with 24 temporal points to 
calculate the daily average. 

 

Each temporary point that we average represents the data in a 
hour of time. If we have monthly data, and we want to make an 
annual average, we will be able to average with 12 temporary 
points (the twelve months). Then, and if you click the OK 
button, the next dialog box is shown: 

 

 

 



Castor   
 

 

 

34 

The window allows to visualize the data to make the average. 
It also allows to modify the data or to change them. We have 
two groups of data that can vary in time: Current data 
(velocity and angle) and Outfall data (velocity, pollutant 
concentration and flow rate). These are the current and 
discharge conditions that can vary in time in the numeric 
simulation. 

 

At the top of the dialog box, two different text boxes appear: source 
label and temporal point label.  We can click both arrows to change 
these values and to visualize the data. 

 

Every time that you enable a new average, the software 
allocates to all temporal points the same quantities. These 
quantities coincide with the values that we had in the Current 
and Outfall dialogboxes before enabling an average. To modify 
the current and discharge data in the temporal average, we can 
click Current and Outfall buttons in the dialogbox. Then, and 
if you click the Current button, the next dialog box is shown: 
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Where depending on the used model, some data of the dialog box 
can be modified: Buoyant jet model or Stratified model (see 
calculation models). The Coefficient of stratification, the 
water density and the stratified model option can not be 
modified. There is not interest in varying this data in time. 
To modify these data, we will have before to disable the 
temporary average and to open the outfall and current 
dialogboxes in the Point source Menu and in the Menu of Mixing 
zone data, respectively. To disable the temporary average, we 
will have to click the Temporal average command and to write 1 
in the textbox of the Number of temporal points. 

 

If you click the Outfall button in the Temporal average: data 
dialogbox, the next dialog box is shown: 
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Depending on the used model, some data of the dialog box can 
be modified: Buoyant jet model or Stratified model (see 
calculation models). The Water depth, the Discharge density, 
the Pipe angle, Diffusor length, T90, Discharge conditions 
option and option of Number of openings can not be modified. 
There is not interest in varying this data in time. To modify 
these data, we will have before to disable the temporary 
average and to open the outfall dialogbox in the Point source 
Menu. To disable a temporal average, we will have to click the 
Temporal average command and to write 1 in the textbox of the 
Number of temporal points. 

 

Before running the calculation it is convenient to check the 
data that we have in the average. 

 

If we enable an average with more than a temporal point, and 
if later we increase the number of temporal points, it is 
necessary to be careful since there are data that can have 
null value. The ideal procedure is to define well, and from 
the beginning, the number of temporal points before writing 
the values for the average. If we want to modify an activated 
average it can be more comfortable to delete the activated 
average and then to define one new. To delete a temporal 
average, we will have to click the Temporal average command 
and to write 1 in the textbox of the Number of temporal 
points. 

 

 

Delete.- This command is used to delete pollutant point 
sources that we don't want in the simulation. If you click the 
Delete button, the next program window is shown: 
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Clicking on these points we will delete them of the screen and 
of the calculation. 

Scale.- With this command, we will decide the work area size 
in the simulation process. It is an important tool because 
with their good use we will be able to interpret and to 
extract interesting data of the numeric simulation. The scale 
is defined according to the width in meters that we want to 
associate to the X-Axis of our program window. If you click 
the Scale button, the next program window is shown: 
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In this window we will be able to choose the number of meters 
that we want to have in the X-Axis. When we have the value 
written in the textbox, we will make click with the mouse on  
Accept button and this value will be modified and the previous 
window will disappear.  If we click the Cancel button it 
closes the window without modifying the value. This command 
will be used before using the calculation command, since this 
parameter should be perfectly defined before making the 
simulation. When we use this Scale command the program, we 
clean the whole screen of the computer and we lose all the 
elements of the simulation placed previously. If we don't want 
to lose the information obtained until the moment we will use 
the Save command before executing the Scale command. 

 

In certain situations, it can be interesting to have a high 
number of meters in the X-Axis for a better visualization. To 
illustrate the use of this command, we will carry out the same 
simulation varying the scale. We will use three different 
scales. Here, the width of the X-Axis is 100,000 m. 
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Here, the width of the X-Axis is 1,000 m. 

 

 

Here, the width of the X-Axis is 10,000 m. 
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As we can see, when the X-Axis is 10,000 m, it is when we have 
a clearer representation, where it is shown the value of the 
maximum point and the concentration lines clearly.  

 

XY-Calculation and XZ-Calculation.- The calculation commands 
run the necessary algorithms to carry out the numeric 
simulation. We will run the command after having fixed the 
necessary data for the simulation, that is to say, the 
outfalls, the currents, the scale,... If we change any initial 
data (as the position of the source, velocity of the 
current,...),  we will need to run the command again so that 
this is reflected in the result. We will be able to choose 
between XY-Calculation and XZ-Calculation commands to obtain 
different pollution maps. If we make click on XY-Calculation 
command, we open the following window : 

 

 

 

 

 

 

 

In this window we will be able to choose if we want to carry 
out the calculation in the surface of the water or to a 
certain depth (two options). In the first option, the 
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calculation of the pollutant concentrations will be carried 
out in the surface of the water. If we choose the option for 
the calculation to a certain depth, we will write in the 
textbox the plane height in which we will obtain the results 
(0m for the surface of the sea). 

 

If we make click on XZ-Calculation command, we open the 
following window : 

 

 

 

In this window we will be able to write the distance to the 
origin (inferior left point of the screen) of the XZ-plane 
that is perpendicular to the surface of the water. On this 
plane we will carry out the XZ-Calculation. 

 

The program works in the following way: while it calculates, the 
machine centers all the capacity of the CPU in the calculation, 
stopping the other tasks of Windows. If we want to stop a tedious 
calculation, we will be able to make it making use of the keys 
CTRL+ALT+DEL.  

 

Note about this command.- Near the source, we can find 
diferences between both XY-calculation and XZ-calculation 
commads. The application uses a numerical grid for valuing an 
exponential function. The small differences between adjacent 
points, when the grid is implemented, can cause different 
concentration results due to the exponential behaviour near 
the source. Far away from the source, these differences can be 
neglected.   
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Colour gradient.- This command is to draw maps of pollution 
making use of a colour gradient. It is specially useful when 
the variation of the concentration of pollutants is very 
strong in a very short distance. The program takes the maximum 
value of the concentration and it assigns to the maximum the 
red colour. Then, the program assigns the different colours to 
the grade of pollution in a qualitative way. We will be able 
to obtain the exact values locating the arrow of the mouse on 
any point and looking at the inferior right textbox of the 
program.  

 

Isolines.- This command is of effect contrary to the previous 
one. We will use this command with the purpose of obtaining 
the isolines again. This way we will be able to change 
representation easily making use of these last two commands. 

 

Numerical grid.- This command allows us another alternative 
representation of the calculated concentrations. It 
establishes a numerical grid throughout the calculation 
screen. It is specially useful if we load topographical 
planes, because with the other representations there are many 
images in the screen. If you click the Numerical grid button, 
the next program window is shown: 
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Calculation parameters.- This command will show us the 
parameters that we have assigned before carrying out the 
calculation. It is convenient their use with the purpose of 
verifying that we have written the parameters correctly. Once 
finish the calculation, the command shows us, also, the value 
of the maximum concentration and its position.  

 

 

6.1.6 Options 
 

The Options Menu includes all the elements for the 
numeric configuration of the simulations. We will use these 
commands before using the calculation command because these 
parameters should be perfectly defined before running the 
simulation. The Options Menu lists: Grid size, Number of 
Isolines, Calculation colours, Fonts, Calculation models, 
Model parameters. When you choose Options in the Menu bar, the 
program displays: 
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Grid size.- The grid size is an important parameter in the 
configuration of the system. We will decide the number of 
calculation points in the grid that we will take to make the 
simulation. As we increase the number of points, the computer 
will take much more time in carrying out the calculation but 
the result will be much more exact. If you click the Grid size 
command, the next program window is shown: 

 

 

 

In this window we will be able to choose the number of grid 
points (calculation points) that we want to have in the X-
Axis. The number of points to calculate will increase 
quadratically with the number of grid points along the X-Axis 
N, that is to say, it will increase as N2. 

 

To increase the number of grid points produces that the program 
needs much more RAM-memory. If we take such a high number of 
grid points that it overcomes the available memory of the PC, the 
computer will be blocked. 

 

Number of isolines.- This command is an auxiliary tool for 
making the maps of pollutant concentration. We will decide the 
number of isolines in the screen that we will take to make the 
representation. In certain situations, it can be interesting 
to have a high number of isolines for a better visualization. 
We will use this command before using the calculation command 
because this parameter should be perfectly defined before 
running the simulation. If you click the Number of isolines 
button, the next program window is shown: 
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In this window we will be able to choose the number of 
isolines that we want to have in our computer screen. To 
calculate the lines, the program also considers to the maximum 
point as a line. 

 

To illustrate the use of this command, we will carry out the 
same simulation varying the number of isolines. We will use 
three different number of isolines. Here, the number of 
isolines is 7. 
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Here, the number of isolines is 17. 

 

 

 

Here, the number of isolines is 3. 
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Calculation colours.- By means of this command, we will be 
able to change the colors of the isolines, of the maximum 
point and of the point sources. 

 

Fonts.- This command is an auxiliary tool for making the maps 
of pollutant concentration. In this command we have three 
different options. We can choose: number of decimal places, 
font size and source label (Yes/No). 
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Calculation models.- We will be able to choose two different 
models to carry out the numeric simulation: Buoyant jet model 
and Stratified model (see Calculation models). 

 

 

 

Calculation parameters.- The parameters that you can modify 
here, are related with necessary algorithms to run the 
simulations. If it is necessary, we have to modify these 
values before running the calculation. 
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6.1.7 GIS 
 

In this option it can be found all necessary to work with 
geographical information system.  

 

Coordinates of the origin.- With this command we can choose 
the value for the origin of coordinates. It is initially in 
the left bottom corner of the program window. It is possible 
to work with geographic and Cartesian coordinates. 
  

 

 

  

Reference points.- With this command we can decide the 
coordinate values of a point, that we previously know, in the 
map in order to have a referenced system. It is possible to 
work with geographical and Cartesian coordinates. After that, 
it will be possible to export the results to a GIS system.  

  

 

 

 
 



Castor   
 

 

 

50 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Radius of curvature.- By means of this command, you can choose 
a value for the Earth radius. This radius can be slightly 
modified to adjust the reference system with the available 
data. The program considers the Earth as a perfect sphere with 
an exact radius. We know that this is not exactly true. This 
option is to correct this kind of effects.  
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Scale calculation.- With this command it is possible to 
estimate the map scale that corresponds to a background image, 
that has trees previously imported by the user. It is 
necessary to know the distance between to different points in 
the map. After introducing the distance data, you can click 
consecutively both points, and the scale will be automatically 
calculated. 

 
  

 

 

 

 

 

 

 

 

 

 

Export maximum, concentrations,….- These are to export the 
different elements of the programs (isolines, source 
positions,…) to Microsoft EXCEL csv file. To import without 
problems with Arcview we have used the english format system 
for the numbers. For example, one euro and 30 cents is 1.30 
euros (NOT 1,30!) in the english format.  
If you are using the spanish format, for example, when you 
open the exported file with EXCEL you obtain “al numbers in 
the same box”. In such a case, the best way is to change your 
number format in your computer. It is very easy. Just go to 
WINDOWS >> START >> CONTROL PANEL >> REGIONAL CONFIGURATION 
and look for english format before opening with your EXCEL 
program. 
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6.1.8 3D 
 

The 3D commands are for a qualitative representation, not 
quantitative. The system generates random points to help you 
to obtain a 3D view of the pollution process. The pollution 
concentration value that appears in the screen is an 
orientative value. In the 3D options you can modify the number 
of random points and other parameters. The TEMPORAL AVERAGE 
command doesn’t work in 3D hasn’t effect on the calculations. 

 

The 3D window is an extension of the 2D XY window. The X 
coordinate, Y coordinate and concentration value that appear 
on the bottom of the screen correspond to the XY plane view. 
The calculated XY data will be deleted after a 3D calculation. 
The PRINT command only prints the XY view. To print in 3D, you 
need to use the PRINT IMAGE command. Or you can save a BMP 
file and print such a file with an another standard program 
(windows PAINT, ...). 

 

 

6.2 Icon bar 
 

The menu bar display the commands you use to build your 
simulation. When you choose one of the menus, the program 
displays a pull-down list of available commands. The program 
window has a basic icon bar under the Menu bar. The icon bar 
provides quick access to commonly used commands in the 
program. You click a button on the icon bar once to carry out 
the action represented by that button.  
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7. Application structure 
 

In this section, the general structure of the application 
will be shown. The Options Menu includes all the elements for 
the numeric configuration of the simulations. We will use 
these commands before using the calculation command because 
these parameters should be perfectly defined before running 
the simulation. 

 If we change any initial data (as the position of the 
source, velocity of the current,...),  we will need to run the 
command again so that this is reflected in the result. We will 
be able to choose between XY-Calculation and XZ-Calculation 
commands to obtain different pollution maps.  

 Colour gradient, Isolines and Numerical grid commands 
should be applied after running the calculation. 

 
Scale 

 
Grid size 

 
Currents 

 
Calculation 
parameters 

 
Outfalls 

 
 

Calculation 

 
Colour gradient 

 
Numerical grid 

 
Isolines 
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8. Mathematical algorithms 
 
 

 The application uses two different mathematical models: 
Buoyant jet model or Stratified model. The Buoyant model is 
ideal for pollutant discharges located in the proximities of 
the coast and in rivers, (using little depth). This model is 
based on a time-independent Gaussian equation which simulates 
the pollutant dispersion in the water. The Stratified model 
takes into account the formation of the pycnocline in the sea. 
This model is ideal for outfall discharges in the sea (using a 
high depth value). 
 
 The program calculates the pollutant concentration in 
each point of the water considering each one of the pollutant 
sources and the conditions of the water.  

 
 

8.1 Buoyant Jet model  
 

 A type of mathematical model that has been developed for 
sumerged round buoyant jets is the length-scale model.  
Discharges flows can be divided into different regimes each 
dominated by particular flow properties. Within each regime, 
the flow may be approximated with simple mathematical 
relations describing the simplified problem. A model that uses 
asymptotic solutions is refered to as length-scale model 
because of length scales to delineate the extent of the 
regimes for which the mathematical expressions are valid. 
 
 The pollutant concentration, in a certain instant, and at 
a distance x (meters) in the X-Axis and at a distance 
y(meters) in the Y-Axis will be given by: 
 

c =cc exp[-(r/b)2] (1) 
 
where c is the pollutant concentration, r is the distance from 
the point (that we are calculating) to the center of the line 
that forms the polluting plume, cc is the pollutant 
concentration in the center of the plume line and b is the 
plume half-width.  
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 We attempt to link the momentum dominated and buoyanvy 
dominated regimes into one relationship by using proposed 
relations for the transition where: 
 
 

z/Lb =24/3[(1/2)(x/Lb)2+(Lm/Lb)(x/Lb)]1/3 (2) 
 

 
 

b/Lb =cb[(1/2)(x/Lb)2+(Lm/Lb)(x/Lb)]1/3 (3) 
 
 
 

S=cs(uo/ua)[(1/2)(Lb/Lm)(x/Lm)2+(x/Lm)]1/3 (4) 
 
 
 

Lb=plume-to-crossflow length scale 
Lm=jet-to-crossflow length scale 
x=horizontal downstream coordinate in global coordinate system 
y=horizontal coordinate in coordinate system perpendicular to 
ambient crossflow 
z=vertical coordinate 
ua=ambient velocity 
uo=discharge velocity 
S=dilution along the plume centerline C/C0 being C the 
centerline pollutant concentration and the C0 initial pollutant 
concentration at the discharge. 
cb=constant of proportionality that can be modified by the user 
(can be determined experimentally) 
cs=constant of proportionality that can be modified by the user 
(can be determined experimentally) 
cxy=constant of proportionality that can be modified by the user 
(can be determined experimentally) 
 

 
 
 We obtain solutions for a vertical buoyant jet in a 
crossflow 
And buoyant jets discharged horizontally perpendiculat to 
crossflow. 
 

z/Lb =cxy(x/Lm)1/3 (5) 
 
 

This model performs satisfactorily for simple flows with no 
shoreline interaction or attachment. Strong crosscurrents or 
limited depths causing attachment with the downstrean bank or 
strong initial buoyancy render this model invalid. In 
addition, they are incapable of simulating any far-field 
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processes that occur after a certain distance. If the z-
coordinate of the plume centerline z_cl is higher than then 
water surface z_ws, the algorithm takes z_cl=z_ws.  
 

8.2 Stratified model  
 

This model is official in Spain and it follows Orden del 
13 de Julio de 1993 del Ministerio de Obras Públicas y 
Transportes del Reino de España, B.O.E. Martes 27 de Julio de 
1993, página 22861, I. Disposiciones generales. Proyecto de 
conducciones de vertidos desde tierra al mar. 
 
 
Density and thermal stratification: The intense heating caused 
by sunlight results in the formation of a light, warmer layer 
of water floating on top of a much larger mass of cold, dense 
water. Where these two bodies of dense water meet there is a 
zone of rapid change in the water temperature, called the 
thermocline or pycnocline. Such a thermocline is a permanent 
feature of both tropical and temperature waters. When the 
surface water of temperature seas is warmed in the summer a 
further seasonal thermocline can develop much closer to the 
surface. This is much stronger feature than the permanent 
thermocline in temperature waters. This thermocline plays an 
important role in determining seasonal changes in marine 
primary production in temperature seas. Thermal stratification 
represents a physical barrier to the mixing of the water 
column. There is little or no exchange of nutrient through a 
thermocline.  
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The stratification phenomena is the existence of two 
homogeneous water layers and separated by a thin thermocline 
layer. In such a case, we can say that the water is 
stratified. There is no exchange of pollutants through this 
pycnocline layer. 
 

 
 

In case we suppose that a pycnocline layer exists, we 
will be able to check the stability by means of the 
application of the following equation: 
 

[u02 B+ Ua2 H]/[(u0 B g’)2/3 H] <0.54 
 
u0=effluent velocity (m/s) 
H=water depth at discharge position (m) 
g’=reduced gravity acceleration (m/s2), g’=g(ρa- ρ0)/ ρ0 
g=9,81m/s^2 (gravity acceleration) 
ρa=water density (Kg/m3) 
ρ0=effluent density (Kg/m3) 
 
Typical values (pollutants): 
Organic matter as DBO5 - 350g/m3 
Suspended matter - 600g/m3 
E. Coli - 1012 /m3 
N2 (total) - 30 gN/m3 
Effluent velocity - entre 0.6 y 0.8 m/s 
Port diameter - 6cm 
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Dispersion coefficients: 
 

Horizontal dispersion: Ky(m2/s)=3x10-5 B4/3.  
B=initial plume width(m) 

 
Vertical dispersion: Kz(m2/s)=4x10-3 Ua e 
e= thickness of the mixing layer 
Ua=horizontal ambient velocity (m/s) 

 

8.2.1 Water is not stratified 
 
8.2.1.1 Multiport diffuser.- We have three different cases: 
 
Case I:   
 
θ >=65º   F<=0.1 ó 
θ <65º   F<=0.36 
θ=angle between Ua vector and diffuser. 
F=Fraude number F=Ua3 (g’q)-1 

q=Unitary flor rate in the diffuser q=QLt-1 (m2/s) 
Q=Discharge flow rate (m3/s) 
Lt=Diffuser length (m) 
S=initial dilution 
 
In such a case, we have the next relationships 

 
S=0.27 Ua H q-1 F-1/3 

e=0.29H 
B=SQ/eUa 

 
Case II:   
 
25o=<θ <65º  F>0,36 (*) 
 
In such a case, we have the next relationships 

 
S=0.38 Ua H q-1  

B=max[Ltsin θ; 0.93Lt F-1/3] 

e=SQ/BUa 
 
Case III:   
 
θ <25º  0,36<F=<20 
 
In such a case, we have the next relationships 
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S=0.294 Ua H q-1 F-1/4 

B=max[Ltsin θ; 0.93Lt F-1/3] 

e=SQ/BUa 
 
Case IV:   
 
θ <25º  F>20 
 
In such a case, we have the next relationships 

 
S=0.139 Ua H q-1  

B=max[Ltsin θ; 0.93Lt F-1/3] 

e=SQ/BUa 
 
Case V:   
 
θ >65º  F>0,1 
 
In such a case, we have the next relationships 

 
S=0.58 Ua H q-1 

B=max[Ltsin θ; 0,93Lt F-1/3] 

e=SQ/BUa 
 
From Case II to Case V, and if e>H, we take e=H and S= UaBH/Q. 
 
8.2.1.2 Separated ports.- We will solve this case by means of 
a iterative mathematical method 
 

B=max[Ltsin θ; 0,93Lt F-1/3] 

S=0.089 g’1/3 (H-e)5/3 Qb-2/3 

e=SQ/BUa 
 
Qb= flow rate at each single port(m3/s). 
 
The number of iterations can modify by means of the parameter 
N_it of the function Calculation parameters of the program.  
Increasing N_it value, we increase the numeric convergence but 
we will need more time of calculation. We should look for an 
optimized value of N_it.  
 
Single port.- In such a case, we have the next relationships 
 
 

e=0.15H 
S=0.089 g’1/3 (H-e)5/3 Q-2/3 

B=SQ/eUa (*) 
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However, at high velocity values and if B<=0.3H, the 
approximation is not correct . 
 

8.2.2 Water is stratified 
 

In this case, the pycnocline or thermocline has been 
formed. We will distinguish the following cases: 
 
8.2.2.1 Multiport diffuser.- In such a case, we have the next 
equations 
 

ymax=2,84 (g’q)1/3 Г -1/2 

S=0,31 g’1/3 ymax q-2/3 

B=max[Ltsin θ; 0,93Lt F-1/3] 

e=SQ/BUa 

 
where Г=-(g/ρ)dρa/dy is the stratification coefficient (s-2) 
and ymax is the thickness of the mixing layer (m).  
 
8.2.2.2 Separated ports.- In such a case, we have the next 
equations 
 

ymax=3,98 (g’Qb)1/4 Г -3/8 

S=0,071 g’1/3 y5/3max Qb-2/3 

B=max[Ltsin θ; 0,93Lt F-1/3] 

e=SQ/BUa 
 
8.2.2.3 Single port.-  
 

ymax=3,98 (g’Q)1/4 Г -3/8 

S=0,071 g’1/3 y5/3max Q-2/3 

e=0,13 ymax 
B=SQ/eUa 

 
For a profile of velocities different from the previous ones, 
it will be required a more complex method of numeric 
integration to solve the problem. 
 

8.2.3 Near mixing zone and distant mixing zone 
 

We need to know the place where the plume centerline 
crosses the water surface or pycnocline layer. To calculate 
this point we will use Ua and the vertical velocity 
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Multiport diffuser.- W=1,66(g’q)1/3 being W the vertical 
velocity of the effluent (m/s). 
 
Separated ports.- W=6,3(g’Qb/H)1/3 . 
 
Single port.- W=6,3(g’Q/H)1/3. 

 
In the last two cases, H will be replaced by ymax when the 
water is stratified. The point localization with regard to the 
place where the plume centerline crosses the surface, gives us 
the near and distant mixing zone definitions. 
 
 

8.2.4 Concentration calculations 
 

The concentration value in a plume point is determined by 
the X,Y,Z coordinates and is given by the equation: 
 

C(X,Y,Z)=(C0/S) F0(t)F1(t)F2(Y,t)F3(Z,t)  
 

C0=pollutant concentration in the effluent 
S=initial dilution 

 
being t=X/Ua. F0(t) takes into account non-conservative 
pollutants and is equal to: 
 

F0(t)=10-t/T90 
  
The F0, F1, F2 and F3 functions depend on being in near or 
distant mixing zone. 
 
(a) Near mixing zone: 
In such a case, the equations are 
 

F1(t)=1 
F2(Y,t)=(1/2)[erf[(B/2+Y)/(σy21/2)]+ erf[(B/2-Y)/(σy21/2)]] 
F3(Z,t)=(1/2)[erf[(e+Z)/(σz21/2)]+ erf[(e-Z)/(σz21/2)]] 

 
being σy=(2Kyt)1/2 and σz=(2Kzt)1/2. The program calculats erf 
function by numerical integration. The the precision of 
integration method depends on the parameter N_int. Increasing 
N_int value, we increase the numeric convergence but we will 
need more time of calculation. We should look for an optimized 
value of N_int.  
 
(b) Distant mixing zone: 
In such a case, we approach 
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F1(t)=(2π)-1/2B σy-1/2 

F2(Y,t)=exp[(-Y2/2σy2)] 
F3(Z,t)=e/Hh 

 
being σy=(B2/16+2Kyt)1/2. Here, we suppose that the plume was 
homogenized vertically when the water depth was Hh, that is the 
depth in the point where the thickness of the plume begins to 
occupy the whole layer of water. The program calculates 
considering the bottom of the sea like a flat surface. Then, Hh 
is the water depth at the location of the deepest outfall. If 
you want to consider a higher water thickness than outfall 
depth, you can draw a deeper outfall whose pollutant 
concentration is null. In asuch a case, the water depth is the 
depth of the deepest outfall. The calculation will not be 
affected by the null concentration of the deepest outfall. 
 
 
(*)We have found, in our opinion, typographic errors in Orden 
del 13 de Julio de 1993 del Ministerio de Obras Públicas y 
Transportes del Reino de España, B.O.E. Martes 27 de Julio de 
1993, página 22861 that we have corrected considering 
mathematical consistency. The software assumes the present 
corrections in the calculation. 
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9. Working with Google maps 
 
 
1. Firstly you can can navigate to Google maps web. 
  
http://maps.google.com/ 
  

 
  
  
2. Using the screen arrows move to the map area that you want 
to watch. For example, we can watch Garachico coast in 
Tenerife North. 
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3. For the image capture, it is possible to use in the 
keyboard Ctrl+Alt+PrtSc). In the keyboard you can push at the 
same time (Ctrl+Alt+PrtSc). In that way, the screen image is 
copied by the computer memory. 
  
  
4. Open the windows PAINT program (Windows >> Start>> 
Programs>> Accessories >> PAINT).  
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5. To paste the image that has been previously copied in the 
computer memory, you can use the commands (Edit >> Paste in 
the PAINT program) or (Ctrl+V). You can watch now the copied 
image from the Google maps web page. 
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6. It is obvious that you don't want to watch the navigator 
bars that appears in the screen. Use the arrows of the PAINT 
program to center the image, that you are interested for, in 
your computer screen. In the toolbar of PAINT, you can use the 
icon SELECT (it is on top of the toolbar and at the right in 
the last picture). Drag the mouse arrow selecting the screen 
area that you are interested for. For our case, it is the 
rectangle where the picture of the terrain appears. 
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7. Copy now the selected area by the rectangle in the last 
image using (Ctrl+C) or the command (PAINT Edit>>Copy) in the 
PAINT program. Then, you can use the command (File>>New) in 
the PAINT to have a new and clear screen 
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8. Use (Ctlr+V) command in the keyboard, or (Edit>>Copy) in 
the PAINT program to paste the selected retangle. The copy of 
the image appears now in the PAINT screen. The scale of the 
map imported from Google maps appears now in our screen 
(marked by a yellow arrow). This will be of great interest in 
a near future. It is important to have this scale in the image 
that you have selected. 
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9. Save the file using BMP format using the commands of the 
PAINT program (File>> Save as. . .). Then, you can open the 
previously saved BMP file using the Castor Software program. 
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10. To work in the correct scale, we need to check the scale 
bar width in the Google map. The Google scale bar is between 
the red and yellow arrows (in the next picture). The Google 
bar width is in meters. When we put the mouse pointer in the 
point of the red arrow we can see the X-Coordinate value in 
the box marked by a blue arrow. If we put now the mouse 
pointer in the point of the yellow arrow, we will obtain a new 
value for the X-coordinate. The difference between both values 
in meters must be the same that the original Google bar width 
in meters to be in the correct scale. 
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When we put the mouse pointer in the point of red arrow, it is 
found 7 m in the X-Coordinate box (marked with a blue arrow). 
If we do the same with the yellow arrow, we obtain 75 m in the 
box marked with a blue arrow. Then, and in our actual scale, 
the bar width have 75 m -7m = 68m. However, the correct value 
in the original Google scale is 100 m. The correcting ratio is  
  
P = 100/68 = (real value)/ (our value). 
  
P=100/68=1.47 
  
  
11. To work in the correct scale, we have two methods: 
METHOD A: 
We go now to Castor Software program>> GIS >> Scale 
calculation in the program and we get 
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We replace the 300m value that appears in the last picture by 
100m (the original Google bar width in meters) and 'click' 
ACCEPT. Then we click firstly in the left extreme of the 
original Google scale bar and secondly, we click again in the 
right extreme of the original Google scale bar (both points in 
the screen were market with red and yellow arrows in the last 
step 10). The imported Google map is now in the correct sale 
and we can check it. When we put the mouse pointer in the red 
arrow, we get an X-Coordinate value equal to 10 m (in the box 
market with a blue arrow). We can also get 110 m for the 
position market with the point of the yellow arrow. The 
difference is now 110 in -10m = 100 m. Such a value coincides 
with the original value of the Google map bar. So, the program 
scale is correct now. 
  
METHOD B: 
We go now to Castor Software program>> Tools >> Scale in the 
program and we get 
  
 
  
 
 
 
 
 
 
 
 
 
 
 
Now we multiply (our actual X-Axis width) by P to get the 
correct X-axis width, 
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(correct X-Axis width)=Px(X-Axis width) 
  
(correct X-Axis width)=1.47x1000=1470m 
  
And we introduce the new X-Axis width and click ACCEPT in the 
last window. The imported Google map is now in the correct 
scale and we can check it. When we put the mouse pointer in 
the red arrow, we get an X-Coordinate value equal to 10 m (in 
the box market with a blue arrow). We can also get 110 m for 
the position market with the point of the yellow arrow. The 
difference is now 110 in -10m = 100 m. Such a value coincides 
with the original value of the Google map bar. So, the program 
scale is correct now. 
  
  
12. Now we introduce a pollutant source and we make the 
simulation. The result can be exported to a BMP file using the 
Castor Software. 
  

 
  
  
13. We can repeat the 6-7-8 steps 'in order to eliminate not 
necessary parts in the picture. At the end we have a clean 



Castor   
 

 

 

74 

image with both the Google map and the simulation process 
results. 
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